' ipsMake.m

TipsMake > Application >Office information >

What isa PivotTable? How to use PivotTablen
Excel

Excel's PivotTable isagreat tool that Microsoft equips into Excel so users can summarize, analyze, learn and
present data more easily. What is a PivotTable? How to use PivotTable in Excel

Excel's PivotTable is a great tool that Microsoft equips into Excel so users can summarize, analyze, learn and
present data more easily.
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TRONG
EXCEL

‘huThuatPhanMemZvn

Suppose you have a data spreadsheet with lots of information below:
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A B C D E F
Tén civa han Qui San phim 56 lwong Pon gid Téng tién
8 P (Chid) | (VNB/Chigc) (VND)
Chi nhanh Ha N&i 1/2018 |Ao sof mi ni¥ 52,871 250,000 13,217,750,000
Chi nhanh Hai Drong  |1/2018 |Dam ni¥ 3,500 600,000 2,100,000,000
Chinhanh HB Chi Minh |1/2018 |Ao so minik 52,590 250,000 13,147,500,000
Chinhénh Hai Deong  [3/2018 |Ao sorminie 38,729 250,000 9,682,250,000
Chi nhdnh Ha N&i 2/2018 |Ao so'minik 41,180 250,000 10,295,000,000
Chinhadnh Ba Ning 1/2018 |DEm nix 4,255 600,000 2,553,000,000
Chi nhdnh Hué 1/2018 |DEm nix 7,358 600,000 4,414,800,000
Chi nhanh H& Chi Minh |2/2018 |[83m ni¥ ) 902 600,000 541,200,000
chinhanh Hai bwong 4201 huThuatPhanVie m . vnsee.eeo 1,003,200,000
Chi nhanh H5 Chi Minh |3/2018 |Ao so mini¥ 43,300 250,000 10,950,000,000
Chi nhanh Hug 2/2018 |Ao s mini¥ 67,163 250,000 16,790,750,000
Chi nhanh Da Ning 2/2018 |Ao sof mini¥ 16,148 250,000 4,037,000,000
Chi nhdnh Hu& 3/2018 |DEm nix 4,675 600,000 2,805,000,000
Chinhanh Ldm Bang  |2/2018 |Ao so minlk 31,419 250,000 7,854,750,000
Chi nhanh Ha Nai 3/2018 |Dam nl¥ 2,718 600,000 1,630,800,000
Chi nhdnh Ha N&i 4/2018 |Pam ni¥ 2,860 600,000 1,716,000,000
Chi nhdnh Ha N&i 4/2018 |Ao so mi ni¥ 54,566 250,000 13,641,500,000
Chi nhénh Hb Chi Minh |4/2018 |Ao so'mini¥ 54,469 250,000 13,617,250,000
Chinhdnh Ldm Bang  [4/2018 |Ao so' minly 32,064 250,000 8,0116,000,000

Now you want to aggregate the data by:

+ Revenue of each store,

+ Revenue of each product,

+ Sales by store by quarter,

+ Quarterly revenue for each item,

+ Draw achart, .

=> The steps are as follows:

Create a PivotTabletable

Highlight the entire data area to be processed.

Then select the Insert tab (1) => PivotTable (2) .
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Tén cira hing Qui San phidm so 'l_'?'"g don glf, Tong tien

1 (Chiéc) (VNB/cChi&c) (VND)

2 |chinhanh Ha Nai 1/2018 |Ao so minir 52,871 250,000 13,217,750,000
3 [chinhanh Hai Dwong  |1/2018 |Bamnir 3,500 600,000 2,100,000,000
4 |chi nhanh HG Chi Minh |1/2018 |Ao so mi nik 52,590 250,000 12,147,500,000
5 |Chinhdnh Hai Duong  [3/2018 Ao 5o mi ni¥ 38,729 250,000 9,682,250,000
6 |Chi nhanh Ha N&i 2/2018 Thii i . ‘A ), 000 10,295,000,000
7 |chinhanh Da Ning 1/2018 dl;lf.l.lnTwh uatPhan M;@ mTVJ“!o,ooo 2,553,000,000
8 |Chi nhanh Hué& 1/2018 |P&m ni¥ 7,358 600,000 4,414,800,000
9 |Chi nhanh HB Chi Minh |2/2018 |B&am ni¥ 902 600,000 541,200,000
10 |chi nhénh H3i Duong  |4/2018 |Bamnir 1,672 600,000 1,003,200,000
11 [chi nhdnh HB Chi Minh |2/2018 |Ao so mi nik 43,200 250,000 10,950,000,000
12 |chi nhanh Hu& 2/2018 |Ao so minik 67,163 250,000 16,790,750,000
13 |Chi nhanh Da Ngng 2/2018 |Ao so minir 16,148 250,000 4,037,000,000
14 |Chi nhanh Hué& 3/2018 |P&m ni¥ 4,675 600,000 2,805,000,000
15 |Chi nhanh Lim Béng 2/2018 |Ao s miniy 31,419 250,000 7,854,750,000
16 |Chi nhanh Ha N&i 3/2018 |P&m ni¥ 2,718 600,000 1,630,300,000
17 |chi nhanh Ha Nai 4/2018 |Dam nir 2,860 600,000 1,716,000,000
18 |chi nhanh Ha Nai 4/2018 |Ao so mini 54,566 250,000 13,641,500,000
19 [chi nhanh HB Chi Minh |4/2018 |Ao so mi nik 54,469 250,000 13,617,250,000
20 |Chi nhdnh Ldm Déng 4/2018 |Ao so mini¥ 32,064 250,000 8,016,000,000

The Create PivotTable window appears.
Select (1) Select atableor range.
(2) You can selectNew Wor ksheetorExisting Wor ksheet.

(3) ClickOK .

1apies HIUSTratons “narts LINKS
Al - I | Tén cita hang
A B e D E F G

nnielelie el ety Ittt Attt Bl e ieiuniniel el ineetirfell Belataltel Pt !

' S0 luong Bongia Tong tién !
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1 & a P ichigal | (vNB/chiga (VND) :
2 \chi nhanh Ha NGi Create PivotTable ? .3,217,750,000 ¢
_— e

3 'Chi nhanh Hai Duon 2,100,000,000 ¢
}—“g Choose the data that you wan* tr. =nalyze =

4 Chi nhanh HE Chi Minl _ .3,147,500,000 |
—— (@) Select a table or range S E——

5 !Chi nhanh Hai Dwong - \) A —, 9,682,250,000 |

P - s T + | 'Bi ' : E|

& !Chi nhanh Ha N&i  TebleRange: |'Big dita A 1:47420 M1 5,295,000,000 |
————— N =

7 iChi nhanh Da Ning O RN e 2,553,000,000 !
8 iChinhanh Hu& 4,414,800,000 ¢
—_— ) -

5 'chi nhdnh H& Chi Minl EOUEETITEE 541,200,000 }

10 jChi nhanh Hai Dugng  Choose wherfth uThuatP-ha nM em.vn 1,003,200,000 ¢

11 !Chi nhdnh HE Chi Minl () New Worksheet (-2‘) 10,950,000,000 |
12 iChi nhanh Hug& xisting Worksheet | | & 6,790,750,000
13 !Chi nhénh D3 Ning Location: bl F&  4,037,000,000 ¢
14 iChi nhdnh Hu& 2,805,000,000 ¢
15 'Chi nhanh Ldm Béang II('s)f”E' 7,854,750,000 !
16 iChi nhanh Ha N&i ST oA p— "u"ud,bw 1,630,800,000
17 'Chi nhanh Ha Noi 4/2018 |DEm nir 2,860 600,000 1,716,000,000 |
18 iChi nhénh Ha N&i 4/2018 |Ao so mini¥ 54,566 250,000 13,641,500,000 |
19 iChi nhanh H Chi Minh |4/2018 |0 so mi ni 54,469 250,000 13,617,250,000 ¢
20iChinhanhLam8dng _ |4/2018 |Aosoming | 32,064 250000 ] 8,016,000,000 1
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The PivotTable Fields window appears in the left corner of the screen.
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Now our job is drag and drop.
Simple data processing
For example, you want to sum the revenue of each store:
1. Select the Store Namelineto drag it into the Rows box .
2. You select the Total money (VND) line and drag it into the Values box .
A B I PivotTabie Field List v x

Choose fields to add to report: BT
[#]Tén cira hang .(._1 ‘)‘

Row Labels | Sum of Tong tién (VND) Sg:r" i -

Chi nhanh Da Ning 6,590,000,000 156 Iong (Chig)

[1®an gia (vMB/Chigc)

Chi nhdnh Ha N&i 40,501,050,000 From o) (D)
Chi nhanh Hai Duong 12,785,450,000

Chi nhanh H8 Chi Minh 38,255,950,000

Chi nhanh Hué 24,010,550,000 3

Chi nhanh Lam bang 15,870,750,000

Grand Total ThuthuatBhanMem.vn

Drag fields between areas below:

¥ ReportFilter H Column Labels
1] RowLabels E  Values
Téncrahang ~ Sumof Téng ... ™

|| Defer Layout Update

M| Sheetl | Sheet2 - Bigdata %2 B

Data processing under many different conditions/ infor mation

For example, you want to cal culate the revenue of each store by quarter :



1. Select the Store Name line and drag it into the Filters box .
2. You select the line Qui dragged into the Rows box .
3. You select the Total money (VND) line and drag it into the Values box .

A B C PiyotTable Field List v _x

Tén cira héng (A”) = Choose fields to add to rom~5 9 ‘:'E T
[¥]Tén cira "*2'"' \ (" 7'.) |

Row Labels -] Sum of Téng tién (VND) fé";phsm( H)

1/2018 35,433,050,000 [ 156 lrong (chigc)
[1®on gid (vNB/Chigc)

2/2018 39,518,700,000 o) (3

3/2018 25,068,050,000 >

4/2018 37,993,950,000

Grand Total 138,013,750,000

ThuThuatPhanMem.vn

Drag fields between areas below:
7 Report Filter i Column Labels

Ténarahdng =~

1] RowLabels ¥ values

Qui - Sum of Téng ... *

~ M| Sheetl | Sheat2 Bigdata .~ ¥J

Y ou want to see data of a specific store, select cell B1, click the store you want to see, for example, you select
Hanoi Branch (1) => click OK (2) .
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1 Tén clra hang (All) -
7 - (Al
i Chi nhdnh B3 Nang
3 Row Labels (-] Su [cimanrsra ] (,]))
i Chi nhanh Hai Dirdng= "=
4 11/2018 i 13 hi o |
5 2/2018 | it Lo S0
6 3/2018
7 42018 ThuThuatPhanMem:vn
8 Grand Total [ Select Multiple ttems
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For example, if you want to compar e sales between stores by quarter, you can do the following:

1. Select the Store Namelineto drag it into the Rows box .
2. You choose theline You pull into the box Columns.
3. You select the Total money (VND) line and drag it into the Values box .



1

2

2 Sum of Tang tign (VND)
4 Row Labels

5 Chi nhanh Da N&ng

& Chinhanh Ha N&i

7 | Chinha&nh Hai Drong
8 Chi nhanh H8 Chi Minh
9 Chi nhanh Hug

Chi nhanh Lam Bdng
Grand Total

M 4 b M| Sheetl

Sheet2

Column Labels |~

- 1208
2,553,000,000
13,217,750,000
2,100,000,000
13,147,500,000
4,414,800,000

2/2018
4,037,000,000
10,295,000,000

3/2018

1,630,800,000
5,622,250,000
10,950,000,000
2,305,000,000

541,200,000
16,790,750,000

7,854,750,000
39,518,700,000

35,433,050,000 25,068,050,000

ThuThuatPhanMem.vn

Big data -~ ¥J I

4/2018

©oF

15,357,500,000
1,002,200,000
13,617,250,000

8,016,000,000
37,993,950,000

PivotTable Field List v

X

Choose fields to add tr reert:

¥lQui (] -
[san ph.(,g,)

156 luong (chigc)

[ ]Pan gid (vNB/Chigc)

[¥] Téng tign (VD) (3)

Drag fields between areas below:

¥ Report Filter H Column Labels
Qui -
5] Row Labels X Values

Téncrahang ~ Sum of Téng ... ~

Report format

Y ou can design and reformat the report according to your actual needs by selecting the Design tab and selecting

until you like.
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Pivot table example - Microsoft Excel

Pagelayout  Formulas Data Review  View

V| Row Headers Banded Rows

V| Column Headers Banded Columns

PivotTable Style Options

PivotTable Tools

PivotTable Styles

D7 - (

fx | 9682250000

Sum of Tong tién (VNB)
Row Labels

Chi nhanh & Nang
Chi nhanh Ha N&i

Chi nhanh Hai Duong
Chi nhanh H Chi Minh
Chi nhanh Hug

Chi nhénh LAm Bang
‘Grand Total
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B c D

Column Labels |~

- 12018
2,553,000,000
13,217,750,000
2,100,000,000
13,147,500,000
4,414,500,000

4,037,000,000
10,295,000,000  1,630,800,000
5,622,250,000
10,950,000,000
2,805,000,000

541,200,000
16,790,750,000

7,854,750,000
39,518,700,000

35,433,050,000 25,068,050,000

15,357,500,000
1,002,200,000
13,617,250,000

2,016,000,000
37,993,950,000

wehuThuatPhanMem.vn «..ore

6,590,000,000
40,501,050,000
12,785,450,000
38,255,950,000
24,010,550,000
15,870,750,000
138,013,750,000

Create PivotChart from PivotTables

Place the cursor in the data area of ?2the PivotTable table, select the Insert tab (1) => Chart (2) .




Do) 9-0- )+ Pivot table example - Microsoft Excel PivotTable Tools
——/ He .‘l I) Insert Page Layout Formulas Data Review View Options Design @ - =
L§|cnp Art P Line -y Area — () [E] Text Box &% Signature Line ~
o
4 She n &B Pic ~ EScatter' =) ] Header & Footer 'gd Object
PivotTable Table Plct Column Hyperlink
¢ s - Bwsar~ 1) Other Charts - & wordart - £2 symbol
Tables lllustrations Charts of | Links Text
E9 - I | |
A B c D E E G H
1
: . ThuThuatPhanMem.vn
3 | Sum of Tang tién (VND) Column Labels | —
4 | Row Labels -| 172018 2/2018 3/2018 4/2018 Grand Total
5 |chi nhanh B2 Nang 2,553,000,000  4,037,000,000 £,550,000,000
6 |Chi nhanh Ha N&i 13,217,750,000  10,295000,000  1,630,500,000 15,357,500,000 40,501,050,000
7 |chi nhanh Hai Drong 2,100,000,000 5,682,250,000 1,003,200,000 12,785,450,000
8 |Chi nhanh HB Chi Minh 13,147,500,000 541,200,000  10,950,000,000 13,617,250,000 38,255,950,000
9 |chi nhanh Hué 4,414,300,000 16,730750,000  2,305,000,000 24,010,550,000
10 |Chi nhanh Lam Bang 7,854,750,000 8,016,000,000 15,870,750,000
11 |Grand Total 35,433,050,000  39,518,700,000  25,068,050,000 327,993,950,000  138,012,750,000
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The Insert Chart window appears, select the chart template you intend to use, and thisis the resuilt:

18,000,000,000
inhana| 16,000,000,000 im Bing
13,2173 14,000,000,000
10,2350 B Chinhanh 82 Mang ,750,000
1,630.4 12,009,090 B Chi nhinh Ha Ngi
15,357,1 10,000,000,000 ChinhinhH _,'D _ (300,000
10,5013 5,000,000000 ® ChinhanhHai Dwrong :750,000
i & 000,000,090 Chinhanh H3 Chi Minh  °
’ ! ! B 1h 18
seonswo | 1NUTHUAtPhAN IVI em:vn
B Chi nhanh Lam Bng
2,000,000,000

1/2018 2/2018 3/2018 4/2018

Above are some of the operations to use the basic Pivot table tool to analyze data in Excel, so you can easily
synthesize the necessary data, draw charts ssmply and quickly. The fastest service for your work. Good luck!

Y ou finished reading the article "What is a PivotTable? How to use PivotTablein Excel" edited by the
TipsM ake team. We hope this article has provided you with many useful tech tips and tricks. Y ou can search for
similar articles on tips and guides. Thank you for reading and for following us regularly.
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